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Executive Summary

The objective of this report is to introduce and discuss research work completed to-date
(March 2001- Jan 2003) and plans for further development on task 6, visualisation
development: whole building components visualisation of the VIRCON project. To
complement the visualisation of the whole building, a parallel visualisation
development of special trade is being carried by the University of Wolverhampton
under task 7 of the VIRCON project.

As stated in the case for support and the subsequent discussion and elaboration on the
methodology with the VIRCON team, the objective of task 6 was to develop a
methodology for integrating standard scheduling software with the 3D models of the
whole building and activities based models for the visualization purposes. Based on the
current development of tasks 5 (Prototype CSA) and 2 (data capture), task 6 seeks to
develop a methodology for visualising and extracting weekly space availability for
construction tasks throughout the site construction operations.

The main focus of this report is the development of the ProVis visualisation tool. The
tool, developed using VBA for Windows, accessing the integrated products and
processes from the VIRCON database and produces 4D (3D+time) and space
visualisation in AutoCAD environment.

In order to achieve the visualisation processes, a number of developments were
undertaken:

e A methodology for establishing a dynamic link between WBS (work breakdown
structure) and CPM with 2D/3D visualisation of the building was developed and
based on the Uniclass approach.

e A space visualisation methodology was developed.

e A software application to facilitate integration (translation) between propriety CPA
applications and the database was developed. No commercial 4D visualisation
software was used to achieve the visualisation process. This development
methodology that solely built on the current industrial tools was seen to be a major
achievement of task 6.

The report is organised into five chapters. Chapter 1 introduces the objective of Task 6,
scope and input requirements for the visualisation development. Chapter 2 details
information and process flowchart for the visualisation development following the
ProVis approach. Chapter 3 describes the ProVis prototype and discusses visualisation
results obtained from running the ProVis using the School of Health as a case study.
Chapter 4 compares the approach being used in the visualisation development with
current research initiatives in USA, UK, EU, and Australia. Finally, chapter 5
summarises the progress achieved to date and future work.
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Chapter 1 Introduction

1.1 General

As a part of Virtual Construction Site (VIRCON) project funded by Engineering and
Physical Sciences Research Council (EPSRC)’s research programme award no.
GR/NO00876, this document reports on the progress and deliverables of Task 6:
Visualisation development of building architectural components managed by University of
Teesside. This task is a continuation effort from the work carried out in Task 2 in which
construction product and process data of the School of Health Project, University of
Teesside were captured and stored in a specific-purpose-developed database called
‘VIRCON Database’.

The main objective of this task is to develop a methodology and an economic desktop tool
to visualise both building products being constructed and space availability for
construction processes at any stage according to the preliminary schedule. It is envisaged
that the users will be able to visually detect problems related to logic of schedule and time-
space conflict by the assistance of this tool. It should also be noted that this task has been
undertaken in parallel with Task 7, which its visualisation development specifically
focuses on building services and groundwork operations.

1.2 Scope and Input Requirements

The building architectural components being included in Task 6 are all foundations,
columns, beams, floors, walls, roofs, doors, and windows of the Teesside School of Health
Project. To enable the visualisation development of these components, this task uses
product and process data initially gathered and stored in the VIRCON database. These data
include 2D CAD drawings, geometrical data (width, length, and coordinates), and program
of work (Work Breakdown Structure, activity start and end dates, etc).

However, during the course of this task, additional meetings were held with a
representative of AMEC Capital Projects who was the general contractor responsible for
the whole building construction of the project. Supplementary information including
utilisation and space requirements of resources such as labour, materials, equipment, and
temporary supports were discussed, recorded, and populated in the VIRCON database.
Furthermore, site layout, construction methods and execution patterns were interpreted
from the contractor’s progress reports so that the visualisation development can intimately
reflect the real scenario.

As the input requirements to the visualisation development, Figure 1.1 to 1.4 presents 2D
CAD Drawing, Work Breakdown Structure, Resource Utilisation and Allocations, and
Population of Resource Information in the VIRCON Database respectively.
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Chapter 2 Visualisation Development Processes:
The ProVis Approach

2.1 General

The proposed aim of the VIRCON project is to develop a strategic planning support system
for evaluating, visualising and optimising construction schedules within a desktop
environment. To achieve this aim, a system architecture encompassing a core repository of
construction product and process data (VIRCON database), a 4D simulation and
visualisation tool, and a space-time analysis tool (SpaceMan) has been initially deliberated.

This chapter explains research methodologies of construction visualisation which have
been developed for the VIRCON project on an easy-to-follow step-by-step basis. The
section is organised in two main subsections namely populating the VIRCON database and
4D visualisation process. The first subsection provides users with processes to
appropriately prepare construction data (CAD drawings and construction plan) for
populating the VIRCON database. The later subsection explains the methodology to
integrate product and process data as a prerequisite for the 4D visualisation. Technical
descriptions for the 4D visualisation in both AutoCAD and VR environment are also
discussed.

2.2 Populating the VIRCON Database

The Task 2 report (Dawood et al. 2001) introduced and discussed data capture and
VIRCON database development. The objective of this section is to detail the process of
populating the VIRCON database for both products and processes.

This section complement the Task 2 report and intends to provide users with a holistic
understanding on how the construction product and process data (from the source
documents) should be manipulated and populated to the VIRCON database. Incorporating
with systematic flowcharts and an example of a Ground Floor Column, the processes for
populating product and process data are elaborated and discussed. The following sub-
sections illustrate the processes of populating construction products and construction
processes.

2.2.1 Process for Populating Product Data

In broadest perspective, construction product data cover all information related to
products’ attributes and characteristics. The product data can be classified into two
categories: 1) graphical data such as dimensions and spatial data derived from drawings;
and 2) non-graphical data such as specifications, method statements, bill of quantities, and
product costs. However, for the purpose of space-time conflict analysis and visualisation,
only CAD drawings produced by the industrial collaborations of the VIRCON project were
used to populate the database.

The process map for populating the CAD drawings to the VIRCON database is shown in
Figure 2.1. Although only one example of a Ground Floor Column is presented, the
process map is drawn in general and therefore applicable to every product in the database.



The populating process consists of eleven steps and five intermediate and final outputs in
total as shown in the figure. The details of each step are described below:

1)

2)

3)

In most circumstances, the layering conventions are varied from one design
organisation to another. In this research project, standardisation of layering has been
made through the use of the BS 1192-5: British Standard for Construction Drawing
Practice (BS 1998). To systematically reorganise layers in the original AutoCAD
drawings, one layer should contain only a specific type of product in a specific area, for
example, Ground Floor Columns. After that, a layering convention based on the British
Standard should be given to each layer i.e. A-G261-M-01_F-Column for the layer of
Ground Floor Columns.

If the original CAD drawings are drawn using variety types of lines i.e. broken lines,
curbs, blocks, the shapes of the drawings have to be edited to form a set of closed
objects using Polylines or circles. It should be noted that this step could enormously
consume time and efforts. In order to avoid this problem in future population of the
database, an agreement with design firms in producing all drawings in the closed
objects manner and following BS conversion should be made at the first stage.

In most cases, the CAD drawings are usually produced in two dimensional (2D)
format. However, generating a very accurate and detailed 3D CAD of the whole project
requires a team of professional CAD drafters and apparently a sound investment. For
experimenting purpose, this project employs a simple technique using ‘Change
Properties’ command in the AutoCAD. The elevation and thickness values of each
product are input which result in a simple 3D CAD. The main outputs by this step are
schematically shown in “AutoCAD (A)” in the Figure 2.1.

The outcome of the above three processes is a 2D-3D AutoCAD model of construction
products organised according to the BS 1192-5 layering convention.

4)

5)

6)

Based on the Unified Classification for the Construction Industry (Uniclass) published
by the Construction Project Information Committee (Construction 1997), a Uniclass
code is assigned each construction product. For instance, the Ground Floor Column is
represented by the Uniclass code of D72111-G26-F134:G261:G311. The code
component D72111, G26, F134, G261, and G311 represents the university building,
the frame structural element, the ground floor, the columns, and the core fabric of
frame, respectively.

The Uniclass code is then added to the database field to create the Uniclass code library
as an intermediate output as shown in “MS Access (B)”, Figure 2.1. The Uniclass
library acts as a unique code in the relational database to identify MS Access tables that
represent construction products.

For each construction product, an MS Access table is created to record all geometrical
data of all elements in a construction product, including the width, length, depth, and
the co-ordinates of the AutoCAD bounding box (including one centre and two points),
and others as schematically presented in “MS Access (C)”, Figure 2.1. This represents
spatial records for products in the database.



7)

8)

9)

The ‘dbConnect’ feature in AutoCAD is used to link AutoCAD and MS Access
through Open Database Connectivity (ODBC). The details to complete this step are
available in the VIRCON database development manual and AutoCAD help file.

To utilise the above function of AutoCAD, a VBA code was developed by the Teesside
research team to extract the above mentioned geometrical data and write to the MS
Access table automatically. An example to show the display of AutoCAD drawings,
and the MS Access data files is given in “AutoCAD (D)”, Figure 2.1.

Each file in a MS Access table should be linked to an AutoCAD object to form a link
template. The detailed procedure for creating the link template is described in Dawood
et al. 2001.

10) A VBA subroutine is developed to create dynamic links between a pair of data record

and drawing object. This allows users to access data of a particular drawing object by
simply click at that object. Vice versa, while the users are browsing through each data
record, the matching object will be zoomed in.

11) To enhance the user friendliness in navigating the database, interfaces are developed

using Access forms and VBA codes. An example interface is shown in Figure 2.1 as
entitled “DB Interface”. Through this interface, the user is able to view the database
and manipulate the construction data by updating the AutoCAD files and re-populating
the database by running the developed VBA code. Some of the drawings of the School
of Health (roof structures and foundations) were not available electronically. Therefore,
the Teesside research team had to spend additional efforts in drafting those products in
AutoCAD and then populated them to the database. Complete data of the whole
building are vital for the visualisation process.
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2.2.2 Process for Populating Process Data to the VIRCON Database

In this report, construction processes are defined as “site and work-face activities that are
required to construct a product”. Three major types of the construction process data namely
time, resource, and space are classified and described as follows:

a) Time data of each activity consists of duration, start and end dates, preceded
and succeeded activities, critical activity, and total slack.

b) Resource data of each activity includes utilisation and allocations of manpower
and equipment.

c) Space data of each activity includes areas required for the construction
processes such as product areas, workman areas, and equipment areas.

Figure 2.2 represents the process for populating the construction process data to the
VIRCON database. This is illustrated by taking the ground floor columns as an example.
The whole process for populating construction processes is divided into seven steps as
numbered in Figure 2.2. With the operation of populating the construction process data to
the database, three outputs are produced. These outputs are the Ms Project (E), MS Access
records, and DB Interface as shown in Figure 2.2. The seven operation steps for populating
VIRCON database are described as follows:

1) Based on the principle of Uniclass, a product-based work breakdown structure (WBS)
approach is used to systematically break down the project activity hence enables
integration of product and process data. The original schedule produced by AMEC was
reorganised into four levels: 1) construction project i.e. School of Health, 2) brief
summary of the construction product i.e. Superstructure, 3) construction product i.e.
GF Column, and 4) construction process i.e. installation of GF Column.

2) Based on the WBS in step 1, time and resource data of each activity is input into MS
Project. It should be mentioned that other construction project scheduling software that
can export data via ODBC such as PowerProject and Primavera could also be used.

3) A Uniclass code is assigned to each construction process. A part of this code represents
the Uniclass code of the construction product to be constructed. For example, the
Uniclass code D72111-G26-F134:G261:G311-JG10z1 represents the construction
process, structural steel framing, to construct the ground floor columns, and it is coded
as D72111-G26-F134:G261:G311.

Outputs of steps 1, 2, and 3 described above will be a MS Project schedule of a
construction project populated with resources.

4) Following the SpaceMan Specifications (North 2001), MS Access tables are created to
record the resource information for each construction process.

5) Similarly, other MS Access tables are created to record the spaces required by each
construction process, including the spaces for construction labour crew, equipment, and
materials as well as the space for hazard prevention. Both resource data and space data
need to be manually input into the database.



6)

7)

All time related data of construction processes are created and populated in an MS
Access table using ODBC connected to MS Project. The contents of MS Access tables
for recording the resources, spaces and time are shown in Figure 2.2 as “Resources
(G)”, “Space (J)”, and “Task (F)”, respectively. The MS Access file Tasks is connected
with the MS Access resource and space tables through another two MS Access tables
“Resource Allocations (H)” and “Work Are Allocations (I)”, respectively.

As described in section 2.2.1, MS Access is well developed for the creation of user-
friendly database interfaces. Both MS Access forms and VBA codes are utilised and an
example is shown in Figure 2.2 as entitled “DB Interface”. In addition, the user is also
able to view the construction process data in the database, and update the construction
process data such as the resource data and space data.
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2.3 4D Visualisation Process

This section discusses the methodology of 4D visualisation development specifically
designed and employed in this research. Comparison of this methodology with other
construction visualisation research projects being conducted worldwide can be found in
Chapter 4.

For this research, the overall construction visualisation approach is shown in Figure 2.3,
which includes ten operation steps, and six intermediate and final outputs. Same as in the
earlier section, the ground floor columns are used to illustrate the case. The following steps
describe the visualisation process.

1)

2)

3)

4)

5)

6)

Section 2.2.1 explains how to revise the original AutoCAD layers in 2D to 3D. Based
on the updated AutoCAD layers as shown in “AutoCAD (D)”, Figure 2.1, construction
products are divided into a number groups. According to the way in which these
products are built and for the purpose of visualising execution patterns, the grouping
process is done in AutoCAD and linked to activities. Both the Uniclass code and the
group names are linked to the construction scheduling in MS Project as well as in MS
Access table.

Each construction product group is integrated with construction activities in MS
Project, and a group name of products is assigned to each construction activity. For
example, in the prototype system (to be described in detail in Chapter 3), one group of
the columns at the ground floor coded as “GFColumn_Groupl” is integrated with the
construction process “steel framing GL K-B/1-5”. Similarly, another group of the
columns at the ground floor coded as “GFColumn_Group2” is integrated with the
construction process “steel framing GL A-M/6-14".

The MS Access table “Tasks” is then updated with the information discussed above by
adding items from the construction scheduling in MS Project as shown in Figure 2.3,
“MS Project (E)” using ODBC. The contents of the MS Access table Tasks is shown in
Figure 2.3, “Tasks (F)”.

To prepare data to be used by the 4D simulator, all MS Access tables including all
construction products, construction schedule, resource data and others are then
integrated using the Structured Query Language (SQL). The sample items to be
integrated are listed in operation (4) of Figure 2.3. Additionally, an example depicting
relationships among these tables is given.

At this stage, the information in the VIRCON database is ready to be accessed by
SpaceMan for spatial analysis. The SpaceMan can feed back to construction engineers
and automatically update the construction scheduling if needed.

A 4D (3D+time) has been developed in the course of this research, called ProVis. A
VBA code has been developed to access data in the VIRCON database and present 3D
of the building at any time during the construction process in AutoCAD environment.
The ProVis was developed to simulate and mimic the process of construction products
on site. The simulation shows space needed at work face as well as 3D products. A

11



7)

8)

9)

screen capture of the ProVis and a simulation output is shown in Figure 2.3,
“AutoCAD visualisation”.

By referring to the space data required by resources, the ProVis performs the
visualisation of construction spaces to confirm the occupied spaces, available spaces
and potential space conflicts. Users can experience space changes as the construction
simulation progresses.

In addition to the visualisation of construction products and construction spaces, the
visualisation of construction process is also possible for the construction engineers to
visualise the construction sequence, pattern, and progress according to the construction
scheduling.

To carry out the visualisation in the VR environment, a VR explorer titled as
DDDoolz4.0 developed by Eindhoven University of Technology is utilised (Eindhoven
2001). This allows a direct conversion from CAD to VR through basic 3D file transfer.
A 3D AutoCAD file is imported to the VR explorer as a 3D studio file.

10) If a 3D drawing at a given date is imported to the VR explorer, it can be visualised and

navigated through the VR model as shown in “VR Visualisation” so that the conflict
problems can be easily detected.

12
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Layout_srea =
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by SpaceMan

Next/Previous Week

Run 4D simulation (an add-in VBA in AutoCAD)
- Input monitor date (by user)

- Interpret data from SQL (by program)

- Generate results on screen (by program)

|

\
v L.

Visualise progress

Visualise space
P of work

Next/Previous Week

l |
v

Import 3DS file to VR Explorer (DDDoolz4.0
developed by Eindhoven)

v

Visualise and navigate through VR model

Figure 2.3: 4D Visualisation Process (An Example of ground Floor Columns)
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Chapter 3 The ProVis Prototype and Visualisation Results

3.1 General

In order to examine the proposed construction visualisation methodologies in practice, the
construction project of School of Health, University of Teesside (entitled the Centuria
Building) is selected to develop the prototype visualisation system (ProVis). This project
with a six million pounds investment is a three-story steel framework structure purpose-
built for the teaching and research targets in medical science. The construction started in
July 1999 and completed in July 2000.

Based on the input requirements earlier described in Section 1.2, four new AutoCAD files
are further prepared to assign the characters of building components and services in the
ground floor, the first floor, the second floor, and the roof, respectively. Initially, all layers
in these four files were of two dimensions only and the values in the vertical direction were
not denoted. Therefore, all layers have to be revised from 2D to 3D individually and
manually. All these layers of AutoCAD drawings are used to establish the geometrical data
of construction products. The construction scheduling created by the construction
engineers in MS Project is used to generate the process data of all construction products.

This chapter presents the conceptualised GUI of ProVis 4D-CAD simulator, the general
framework, and the implementation methodology for visualising construction activities.

3.2 The 4D User Interface and Components

The researchers at Teesside University who produced the ProVis were determined to
produce an easier and more intuitive GUI for construction tasks space visualisations. A key
part of achieving this was designing the GUI to look as an AutoCAD 2000 Add-on, which
integrates the visual elements of the graphical user interface with the 4D simulation model
of the Centuria Building.

The conceptual GUI major components are put together in VBA that is shipped with
AutoCAD 2000. It provides a supportive interface, which links the CAD 3D model
components with VIRCON database records and resources for project activities. A window
tabbed-system interface provides the end-user with the GUI major components. The three
major parts are explained in the following text.

3.2.1 Products Simulation Tab

Figure 3.1 shows an example of the Products Simulation tab associated with 4D player
subcomponents. The users enters a specific monitor date for which the 4D simulation to
start. Users are provided with 4D player buttons: next, previous, auto run, stop and reset
the simulation. The 4D environment loads the weekly 3D-CAD model when the user clicks
on any of these buttons. The simulator displays the 3D geometry with its associated tasks
and resources from VIRCON database by using Database Access Object (DAO).
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Figure 3.1: Products simulation tab interface

The ProVis visualisation is user-interactive and is substantially improved in the Ul
elements such as the *Activity’ and ‘Explore’ buttons. The Ul elements retrieve
construction activities information and allow the user to force a selective visualisation to
show/hide specific tasks within the 4D visualisation. An example of exploring the project
activities can be seen in Figure 3.2 screenshots a, b, and c. A complete description for the
ProVis GUI is supplied in Appendix A, and it includes the operation of the 4D

visualisation.

Activity Lisk

o | vl

Ackiviky Lisk

Progressing

<

Finished

3

PBS-WES Tree

Froject Explarer

=l

| |

=l School of Health -
=] Site preparation
E| ------- Site clears

DI
E| ------- Ground co
= Stabilisatic
- Perimeter
L Te
EI ....... Site accan
b Sk
=-Resited &3
=) Sewer divi

E—_

(a) Activities in progress
list

(b) Finished activities list

(c) WBS of the project
activities

Figure 3.2: Exploring the project activities

3.2.2 Space Visualisation Tab

Figure 3.2 shows the space visualisation tab that gives the user some options in visualising
construction activities at a specific monitor time. Firstly, The space viewer part provides
the user with hide/show options for viewing different building components of the Centuria
3D model. The *‘Draw Spatial Loading’ button displays the Critical Space Analysis (CSA)
results in different colours, as indicated in the ‘CSA Legend’ (Figure 3.4).
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Figure 3.3: Space visualisation tab
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Figure 3.4: Critical Space Analysis (CSA) results

3.3 External Construction Visualisation with Time

Up to now, about 30 construction 3D products have been prepared in 4D model, which
contain the main structural components and temporary construction facilities of the
Centuria Building. The total construction duration is 116 working days from August 1999
to February 2000. Parallel to this, the 4D visualisation of the mechanical and electrical
systems of the same building is being tackled by a joint research group at the University of
Wolverhampton.

The construction visualisation of the Centuria Building has been developed on the platform
of personal computers using Windows 98. Although there are no requirements on the
hardware to run the program, the recommended CPU speed and installed memory are not
less than Pentium 266 and 64 MB, respectively.

A series of screen captures (Figures 3.5 to 3.11) of the visualisation process are presented
here to show the dynamic construction situations of the Centuria Building in various dates.
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As the visualisation simulation was carried out in the unit of week, the displayed
construction situation is the possibly achieving stage during the calendar week of the
monitor day according to the project schedule. Figure 3.5 shows the foundation
construction on 05/09/1999. Figure 3.6 shows the construction situation of columns on
26/09/1999. Figure 3.7 shows the construction situation of floors and wall on 05/11/1999.
Figure 3.8 shows the construction situation of lower trusses of the roof on 12/11/1999.
Figure 3.9 shows the construction situation of the upper trusses of the roof on 26/11/1999.
Figure 3.10 shows the construction situation of purlins of the roof on 14/01/2000. Figure
3.11 shows the whole Ceturia Building after structural construction on 16/02/2000.

Figure 3.12 is an example to show the visualisation of the construction situation of the
Centuria Building using the DDDoolz4.0 VR explorer. The users are able to virtually walk
through the building to visualise the construction site with the navigation of the program.
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Figure 3.5: 4D Visualisation for Constructing Centuria Building
(Foundation Construction on 05/09/1999)

17



Product Simulation | space visuslisation |

Legend
Date | 26-Sepf99  Bak | Run | et | Auto | stop |Reset| Activity | Explorer | Exit ’7 W Progressing [ Temporary [ | Finished ‘|

=

<
S
A

+ BB

L EBaCe

Lo u el e

> B
%Y NE S

W «[¥ M\ Model [Tayoull [ LayoutZ JIEl] B »

SHAF[GRID ORTHO|[FOLAR OSNAP[OTRACK [LwT [MODEL
i@ start “ 16 W & H F¥IRCON _Task_Final - ... || & hutoCAD 2000 - [Scho... WR PN 168

Figure 3.6: 4D Visualisation for Constructing Centuria Building
(Construction Situation of Columns on 26/09/1999)
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Figure 3.7: 4D Visualisation for Constructing Centuria Building
(Construction Situation of Floors and Walls on 05/11/1999)
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Figure 3.8: 4D Visualisation for Constructing Centuria Building
(Construction Situation of Lower Trusses of the Roof on 12/11/1999)
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Figure 3.9: 4D Visualisation for Constructing Centuria Building
(Construction Situation of Upper Trusses of the Roof on 26/11/1999)
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Figure 3.10: 4D Visualisation for Constructing Centuria Building
(Construction Situation of Purlins of the Roof on 14/01/2000)
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Figure 3.11: 4D Visualisation for Constructing Centuria Building
(Whole Building after Structural Construction on 16/02/2000)
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Figure 3.12: 4D Visualisation for Constructing the Centuria Building
(VR Explorer)

3.4 Internal Construction Visualisation with Time

The VIRCON 4D visualisation approach also allows users to view the construction work in
progress from any location by using the Dynamic View command in AutoCAD 2000.
Figures 3.13 to 3.15 demonstrate internal views in different periods to show roof work
progress. As shown in figure 3.13, the lower part of the atrium truss is highlighted in red to
show that work execution is in progress. Figure 3.14 displays the beginning for assembling
the upper part roof and therefore it is highlighted with red. The lower part roof activity is
highlighted with white to show end of activity. In figure 3.15, the roof purlins activity is
progressing and is highlighted with red. Additionally, the roof sheeting activity starts and
is visualised in red.
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Chapter 4 Comparison of the ProVis/VIRCON with Other Research
Prototypes

4.1 General

Still at present construction process planning typically means scheduling and schedules in
Gantt chart format. This kind of a schedule is not a particularly good communication
means for individuals having different background and being not necessarily familiar with
formal scheduling outputs. Today, we must rely solely on the project participants’ ability
to interpret these rather abstract, discipline-specific models to form a mental picture of the
corresponding construction approach. Even a good construction plan often gets
misinterpreted by some of the participants, which can lead to inefficient processes
accomplishing the wrong thing. To increase the quality of the process plans, better models
and simulations of the construction process are needed. This is a one way to decrease the
duration of the projects and same time keeping up the certainty that the schedule is
realistic.

Since 1995, an emergence of 4D CAD (3D plus time) and VR (Virtual Reality)
technologies has potentially enabled designers and builders to communicate the design and
construction process visually, making the communication of design and construction
decisions more comprehensive and faster.

Currently, not only the VIRCON research project conducted by University of Teesside,
University of Wolverhampton, and UMIST, a number of researches in 4D CAD and VR
applications in construction is being conducted by many universities and research institutes
worldwide. Excluding commercial software development companies, these active
universities and research institutes are Stanford University-USA, VTT-Finland, Salford
and Strathclyde Universities-UK, and University of Sydney and Melbourne-Australia.

Each research project has developed its own methodology and technology attempting to
deliver the most informative but the most feasible and economic 4D CAD and VR
applications. Therefore, it is worth to compare and contrast these methodologies with the
one developed in ProVis/VIRCON project. It is envisaged that advantages and
disadvantages of ProVis/VIRCON methodology can be identified and thus provides lights
for future improvement.

4.2 Comparison of 4D CAD/VR Features between ProVis/VIRCON and Other
Research Prototypes

In this section, comparison of 4D CAD/VR features of ProVis/VIRCON is made with
other 10 research prototypes that have been finished or being developed in the active
universities and research institutes as mentioned earlier. An intense review of documents,
published papers, web sites, and the prototypes of those projects was conducted. 50 main
different features of the methodologies and technologies employed by these researches can
be identified. These features then can be grouped into 12 groups including:

1) CAD Visualisation Environment
2) VR Visualisation Environment
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9)

Scheduling Software
Database

Standard Classification
Product-Process Linking
Product Visualisation
Process Visualisation
Space Visualisation

10) Associated Annotations
11) Model Test
12) Applications

The comparison results are presented in Table 4.1

4.2.1 Advantages of ProVis/VIRCON over Other Prototypes

Based on results presented in Table 4.1, advantages of ProVis/VIRCON over other
prototypes can be discussed as follows:

1)

2)

3)

4)

5)

In comparison with others, ProVis solely utilises available commercial software that
widely accepted and used in the construction industry such as AutoCAD, MS
Project, and MS Access for the visualisation development. The VR software such as
DDDoolz 4.0 and VRML can also be downloaded from the Internet with no cost. As
a result, this will promote widely acceptance and usage of ProVis in the industry.

The utilisation of a database as a central information resource base in the
architecture of ProVis makes it possible and relatively easy to incorporate any kind
of information into the 4D/VR model in the future. The additional information can
be cost, cash flow, supply chain constraints, and technical information which will
make the model more informative and useful.

The first implementation of the Unified Classification for Construction Industry
(Uniclass) in ProVis assists planners to systematically breakdown and organise the
project schedule. The form of product-based Work Breakdown Structure forces
planners to prepare schedules that have consistency in level of detail and also avoid
omission of assigning activities to associated products. Once the schedules are
generated in the proper manner, process of linking of product and process data will
be more straightforward hence allows faster development of the 4D model.

Since the ProVis has been self developed using Visual Basic Application (VBA) as
an add-in AutoCAD, it is flexible to customise and improve the prototype in the
future.

The ProVis has ability to generate textual-based annotations and reports of the 4D
analysis. The annotations include list of progressing activities and critical activities.
The reports include space occupation, space availability, and space conflicts
location. This feature can enhance benefits and greatly help users to easily detect
problems while navigating the model.
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6) In ProVis, space requirements by workman, materials, equipment, and temporary
works can be explicitly shown as CAD objects. The interference of the space can
also be highlighted.

7) The space template assignor and/or AreaMan developed in the VIRCON project
allow users/planners to interact and manually assign additional dynamic space
objects such as resource paths, staging areas, and hazard areas to the CAD model.
This feature can substantially improve the model to reflect the real scenario and
generate better analysis outcomes.

8) With the SpaceMan, a critical space analysis and time-space broker engine,
developed in the VIRCON project, the schedule can be automatically optimised and
updated so as to avoid the time-space conflict. After that, the users can verify the
updated schedule by visualising in ProVis and perhaps adjust the schedule based on
their satisfaction.

9) The 4D model generated by the ProVis is from the real live project (Teesside
School of Health Project). Therefore, it is justified that the ProVis can be used in
any real complex projects.

4.2.2 Disadvantages of ProVis/VIRCON under Other Prototypes

Based on results presented in Table 4.1, disadvantages of ProVis/VIRCON under other
prototypes can be discussed as follows:

1) The VIRCON database implemented in MS Access is currently non-IFC complaint.

Justifications for this can be described as follows:

a) Input of the VIRCON database is the non-IFC complaint drawing based design
generated in AutoCAD. Unlike model-based design where each component is
represented as object i.e. foundation, beam, and column, each component in the
AutoCAD is represented as fragmented geometrical shapes i.e. lines, polylines,
and circles. However, it should be noted that the IFC complaint model based
design has not been widely implemented in practices. The existing IFC
complaint CAD software i.e. ArchiCAD 6.5 appears to support only the old
version of IFC (Version 1.5.1) and has no database connectivity feature.

b) Apart from CAD software, no commercial IFC complaint software for other
construction management functions (i.e. project planning and scheduling, cost
estimating and control) is currently available.

c) Without the use of complicated and expensive object oriented database
management software, it has been proven that the 4D model of the real project
can be simulated smoothly. Each simulated progress status can also be exported
to other CAD software using widely accepted data standard such as DXF
format. Therefore, a main limitation of non-IFC complaint of the VIRCON
database is solely inability to share data across non-CAD based software This
limitation is subject to whether or not IFC complaint non-CAD based software
(planning and scheduling, cost estimating) will be available in the future.

2) The MS Access can’t support multi-users and has low scalability. Fortunately, it is
relatively easy to upsize the MS Access database to be a SQL server database using
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3)

4)

upsizing wizard in the MS Access. Once the database is upsized to be the SQL
Server, it will support multi-users and therefore suitable for implementation in the
multi-organizational level. A web-publishing wizard in both MS Access and SQL
server will allow authorised users to access the data from any corner in the world
via the Internet.

The manual grouping of CAD objects and linking to associated activities can
consume time and be cumbersome. The knowledge-based system implemented in
other research prototypes should be concerned in future development.

In addition to interaction and assigning space objects in the CAD environment,

future development should allow users to interact and assign space objects in the
VR environment.
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Table 4.1 Comparison of 4D CAD/VR features between VIRCON and other research prototypes

Research Project

w
<

o
>

@D
<

<
o
o
Q

VIRCON CIFE-Stanford Salford Salford, | VTT Strathclyde
(UT,Uw,UCL, VTT urne
UMIST)

Feasibility
Study (00)
plan (99)

VR
VIRCON

ProVis
Wolv-4D-
VRML
CIFE-4D
CAD (98)
4D
SpaceGen
(00)
Gallicon
OSCON
Divercity
VIRIL
VR site
activity
Planner
97)

(01)

Main Features

s| (01)
=| (01)
s| (01)
| (99)

N

£
>
£
>

N N

CAD Visualisation Environment N/A N

1. AutoCAD (4D) \ V

2

2. AutoDesk WalkThrough

3. Schedule Simulator-Bentley \

4. PlantSpace-Jacobus Technology v

VR Visualisation Environment

1. VRML (3D) N \ \ V

2. VRML (4D) \ V

3. DDDoolz 4.0-Eindhoven ~

4. SuperScape VRT \/ N N ?
5. SG Visualiser N

Schedule Software ? ?

1. MS Project N \ \ \

2. Primavera P3 + ~ N N N

3. CIFE-4D CAD v

3. CA-SuperProject v

Database N/A N/A N/A ? N/A

1. MS Access v v

< (<

2. SQL Server/Oracle

3. OODBMS - ObjectStore v v v N

4. Borland Dbase V3 N

Standard Classification N/A N/A ? N/A N/A N/A

1. Uniclass N N

2.1FC N N v v
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Main Features

Research Project

(UT,UW,UCL,

VIRCON

UMIST)

CIFE-Stanford

Salford

Salford,
VTT

VTT

Strathclyde

Sydney

ProVis

Wolv-4D-
VRML

CIFE-4D
CAD (98)

Feasibility
Study (00)

4D

SpaceGen
(00)

Gallicon

OSCON
(02)

Divercity
(01)

VIRIL
(99)

VR site

activity

plan (99)

VR

Planner
97)

VIRCON

(01)

Product-Process Link

~1 (01)

1. Uniclass approach (Product-
based WBS)

<

2. Manual grouping of CAD
objects

3. Product-Process manual linker

4. Knowledge-based system

< |2

5. Construction Method Modeler

Product Visualisation

1. Show completed products at
start or end date

\/?

2. Show progressing products
during activities periods
(colouring)

N2

Process Visualisation

N/A

N/A

N/A

N/A

N/A

N/A

1. Show temporary works

2. Show storage areas

3. Show resource paths

4, Show hazard areas

< |2 |2 |2

2|2 (<2 <

5. Show process animations

Space Visualisation

-~

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

1. Show space occupied by
activities as objects

2. Show space conflicts

Associated Annotations

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A

1. Simple textual based messages

2. Direct relates planning

Con-
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information to the visual depiction

cept

Main Features

Research Project

VIRCON
(UT,UW,UCL,

UMIST)

CIFE-Stanford

Salford

Salford, | VTT
VTT

Strathclyde Sydney | Melbo-
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4D
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(00)

Gallicon
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VIRIL
(99)
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plan (99)

VR
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97)

VIRCON
=| (01)

Model Test

3| (01)

N

N/A

2

1. Real live project

2

<

<
2|
<

2. Parts of real live project

Applications

1. Detection of consistency in level
of detail of schedule

<

2

2. Detection of omission of
activities in schedule

3. Detection of problems related to
logic of schedule

2| <2| 2| |

< | 2| <

< | 2| <

4. Detection of problems related to
time-space conflict

\/

manual

\/

manual

< | 2| 2| < <2| |=

\/

future

5. Detection of accessibility
problems

< | 2| 2| < <2

< | 2| <] 2| <] ||

\/

manual

\/

manual

\/

future

6. Training/Education

7. Optimisation of schedule to
avoid time-space conflict problems

8. Automatic schedule generation

9. Integration of estimating,
planning, and design

10. Utilisation of space template
assignor

11. Interaction with virtual objects

12. Multimedia information about
process of constructing a building

Legend: \ - meet the criterion with supported documents

\/? — meet the criterion but lack of supported documents  N/A — Not available

? — No information
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Chapter 5 Summary and Future Work

5.1 Summary

The objective of the report was to introduce and discuss the development of the ProVis
prototype as a part of the VIRCON project. The report started with identifying the
approach used to integrate products and processes for the visualisation purposes. To
achieve the 4D visualisations, the VBA macros were developed and embedded in
AutoCAD 2000. The 4D simulation and visualisations includes products, processes, and
critical space visualisations.

5.2 Future Work

o This version of the 4D simulator does not include all the resources associated with
all activities. However, in the later stages, the research team will investigate ways
of assigning standardises resources for the rest of project activities.

o The underlying VBA routines for visualising construction process can be enhanced
in our future work and will be used in various levels to provide extra flexible
support for identifying different types of spatial clashes. Of course, this will include
the provision of other sets of algorithms and heuristics within the simulation model.

o It is expected that further spatial reasoning techniques will be developed to derive
more useful information about the construction clashes.
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Appendix A: ProVis Operation

A.1l General

The operation steps described here are prepared to guide the users when working with the
ProVis prototype. Similarly, the ‘Help’ files are supplied automatically when installing the
ProVis as part of the VIRCON system.

2§ vircon System Documentation {2002) - Microsol Ft internet Explorer

=121

A.2.1 Introduction: welcome new user
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1) Introduction
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Interface
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T) Troubleshooting
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User Guides
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Welcome to the ProVis User's Guide (Product Visualiser). This guide is specially written
for users who are familiar with general concepts of AutoCAD 2000. This guide describes
the main features of ProVis software, information on how to use ProVis, and the basic
steps to produce successful visualisations for your construction project. You will find out
that this guide easily helps you in the following:

= |t contains easy step-by-step information so that you can achieve the best from

running the ProVis software.

= You will find all related technical information for implementing, configuring and
operating the ProVis as an add-on to your AutoCAD environment.

= This guide introduces the main features of ProVis user interface, configuration, set-
up, and takes you through examples of how to run ProVis visualisations.

= This documentation explains how to share your 3D visualisation with other project

team members.
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A.2.2 Introduction: about ProVis software

The ProVis software is the output of an intensive effort and development from the
University of Teesside research team - as part of the Virtual Construction Site (VIRCON).
ProVis has evolved to enable the new generation of project planner to visualise
construction operations through time in 4D (3D + time) according to the project schedule.
The software implements integration methodology among MS Project 2000 scheduling
software, the VIRCON MS Access database, and 3D models in AutoCAD 2000. ProVis
access the VIRCON database and visualises the process of construction products on site.
Users can examine the space needed at work face as well as the 3D product progress in
time.

ProVis utilises the VIRCON database as the central information source for the 4D-CAD
visualisation. The whole information about the resources and the construction operations
start/end duration are fed into ProVis to achieve a typical scenario of how the work can be
executed on site. In addition, ProVis visualises space-time conflicts after critical space is
analysed by SpaceMan tool (time-space broker).

The integration of ProVis and the VIRCON database was developed through the utilisation
of Visual Basic for Applications (VBA) programming language as an add-on to AutoCAD.
The very simple and friendly user interface of ProVis achieves the following functionality:

= A methodology that automatically populate the project database with products
information from the AutoCAD 3D model. This approach establishes a dynamic
link between Work Breakdown Structure (WBS) and CPM with 2D/3D
visualisation of the construction building.

= A 4D space visualisations in AutoCAD environment by accessing the integrated
products and processes from the VIRCON database.

= ProVis utilises the analysis results from SpaceMan to visualise the critical spatial
interference between construction activities in 4D.

A.2.3 Introduction: contacts information

= For general questions about ProVis software please contact Prof. N. N. Dawood at
the University of Teesside.

= For technical support regarding any problems of installation, configuration and
running ProVis software please contact any of the research team at University of
Teesside.
- Eknarin Sriprasert
- Zaki Mallasi

= For other general enquires regarding VIRCON System, please contact Steve North
or visit the VIRCON website for more resources.

A.3.1 Before You Start VIRCON: system requirements
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ProVis runs on top of AutoCAD 2000 or later versions. MS Access 97/2000 is needed so
that ProVis communicates with the VIRCON project database. Additional to this is the
Visual Basic for Application that is shipped with AutoCAD 2000. Finally, you should
make sure that your PC is provided with the latest ODBC drivers installed. The minimum
basic hardware requirements is listed below:

= Processor: Intel processor 650 MHz or more.
= QOperating System: Microsoft Windows 98x, NT
= RAM: 128 MB minimum.
= Hard Drive Free Space: 10 MB
A.3.2 Before You Start VIRCON: installation
A.3.2.1 Files Checklist

The following table lists the files format and the description for each one that you will need
before running the ProVis simulation.

File Name/Path Description

The Microsoft Access database file
for VIRCON

The AutoCAD VBA file project
C:\VIRCON\DataExtractMan\DataExtractMan.dvb [that contains the DataExtractMan

VIRCON.mdb

VBA macros

The AutoCAD VBA file project
C:\VIRCON\ProVis\ProVis.dvb that contains the ProVis VBA

macros
C:\Program Files\ACAD2000\Data The AutoCAD 2000 linked data
Links\VIRCON.udl source file
C:\VIRCON\ProVis\Help\help.htm The ProVis help file
C:\VIRCON\Menu\VIRCON.mns The VIRCON menu file

A.3.2.2 Loading VIRCON Menu to AutoCAD Main Menu

Loading the special designed VIRCON menu to AutoCAD main menu can be done in easy
steps. From AutoCAD Command line type 'menu’ and then press Enter key. The Select
Menu File window opens so that you select the VIRCON.mns file from the correct path
name. Click Open and the VIRCON menu is added next to the AutoCAD Help menu.
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A.3.3 Before You Start VIRCON: database connection configuration

ODBC protocol is among the popular database connectivity protocols. It handles
communication features between Microsoft Windows applications. In the case of ProVis,
the user is required to set up a connection with the VIRCON database by using ODBC.
Throughout this section, we will demonstrate to the user the required steps for establishing

this connection.

A.3.3.1 Establishing the database connection

Users can establish the database connection from within AutoCAD environment. From
Tools pull down menu choose dbConnect and it will open the dbConnect Manager

window.
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Properties Ctrl+1
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Load Application...

Bun Script...

Macro >
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Display Image >
Mamed UCS...

Orthographic UCS 4
Move LICS
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To establish the connection:

1. From the Tools menu select dbConnect and open the dbConnect Manager
window.

2. Right-click the Data Source and choose Configure Data Source.

3. Type 'VIRCON' as the data source name and click OK. This opens the Data Link
Properties dialog box. Then choose Microsoft Jet 3.5 OLE DB Provider.

B Dala Link Propesties

|
= Configure a Data Source EE
Frovcet | Coectien | Advarced | 81 |

Data Sowce Name: I'v'ifﬂﬂff Selec s el ou vk et

0L OF Frovders]
Micocsolt (364 1.1 DLE DE Sovde

Diata Sources:

jet_dbeamples
vicon_exapattemn
yacon_exepatterm_AIBuld

B Frovds for Diace
DE Frovider for SGL Server
Hicrezch OLE DB Sz Prawider
Micrezelt Froect 1.0 OLE £ Provider

ME Femate
MEDaat hape
[ oc | cowa | e |
|
o | e | W |

4. Click Next, and enter the mdb Access file in the path field.
5. Click Test connection.

6. Click OK.

7. Your dbConnect Manager window should contain "VIRCON' in the Data Source
list.
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A.3.3.2 Setting AutoCAD workspace

There are several issues to consider before running the ProVis and visualise construction
activities in 4D. The developed methodology for preparing the AutoCAD 3D model
components is presented here. This section describes the necessary preparation steps for
setting AutoCAD workspace before using ProVis. The example used here is the Ground
Floor Columns. The details of each step is as follows:

1. Obtain all project CAD drawings such as: architectural, mechanical, electrical,
structural or any other related information. It is a good housing style to keep a copy
of the original CAD drawings saved in a separate folder on your computer.

2. From the pull down menu in AutoCAD go to Format then choose Layer to
display the Layer Property Manager window. Here you will need to create a new
layer for the ground floor columns and name it according to the British Standards
(BS 1192-5). Notice that the Element field of BS layering contains the PBS product
code based on the Unified Classification for the Construction Industry (Uniclass).
Therefore, the code for ground floor column example should look like
F134 G261_G311.
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3. This step involves the editing of the existing 2D drawn shapes in the existing
CAD layer and reproduces them in a new layer. In most CAD-drafting culture, the
original CAD drawings are drawn using variety types of lines i.e. broken lines,
curbs, blocks, the shapes of the drawings have to be edited to a set of closed objects
using Polylines, lines and circles. For the ground floor columns example, the user
should use Polylines (use 'pline’ AutoCAD command), as it will result in 2D closed

shapes.

— 1 1) Steel Column
drawn in separate
lines

I T/ 2) Steel Column

drawn in Polyline

(1) (2)
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4) To convert the previous 2D shapes into 3D you use the Change Property
dialogue box in AutoCAD. The Elevation (i.e. projection value from zero ground
level) and the Thickness values of each product are input which results in the new

3D shape.

Properties - Drawng] dwg

I:'D|y’il"e _'J \__?J

lphabetic  Categorized I

B General
Color W ByLayer
Layer 1}
Linekype
Linetype scale
Plot style
Lineweight
Hyperink,

ByLayer

ByLayer

200

B Geomebry
Vertex 1
WYertex 1 130.7476
Yertex 200.7405
Start segrment width 0
End segment wicth 0
Global width 0
Elevation 0
Hrea

B Misc
Closed Yes

|»

|

pecties the thickness of the lightweight polyline

5) Manual grouping of 3D CAD components within a layer is an appropriate
technique for describing each construction activity, or phase/stage of work. For
example, you can make two groups of ground floor columns and name them as
GF_Columns_G1 and GF_Columns_G2 to match the programme of work. To
group the components type ‘group’ in the AutoCAD command line and it will open
the Object Grouping window. Enter the new group name in the Group Name field
and then click New to select the 3D components.
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6) Open the Tasks table in the VIRCON database in order to update and link each
3D model groups with its processes in the project schedule. This is achieved by
adding the group names previously created to the Product_Group column of the
Tasks table. The full details to complete this step are available in the VIRCON
database development manual.
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7) Adjust your AutoCAD display area to match your convenience. From the pull
down menu click on View then choose Viewports to adjust the required number of
views to view the 4D simulation.
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8) Finally, always remember to save your work before proceeding to running
ProVis simulation.

A.4.1 ProVis User Interface: main menu

ProVis main menu sits across the top of AutoCAD window. This interface was mainly
implemented in order for ProVis to look like an add-on AutoCAD.

Select Menu File [ 2]

Laak in: IaMenu j ﬁl alll
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The two ProVis sub-menus are:

1. Run DataExtractMan: this sub-menu initialises the automatic population
process of the VIRCON database. It is useful because it reads all 3D geometrical
information of the product components in CAD layers and extracts their space
properties to the product tables in the database. For each construction product, an
MS Access table is created to record all geometrical data of all elements in a
construction product. The information includes the width, length, depth, the
Uniclass code, and the co-ordinates of the AutoCAD bounding box (including one
centre and two points). This represents spatial records for products in the database.

An example name for a populated product table for the ground floors columns is
PR_01 01_COLUMNS

Extracting Product Data to YIRCON| x|

DataExtracti¥an Yersion 1.0
Copyright 2002

UHIVEREITY ©F
TEESSIDE

This program will extract geometrical data from all product
layers and populate the YIRCON Database.

Before running this program, please check the Following:

1.That .mdb file contains no product or uniclass tables,
2.That praduct laver names follaw YVIRCON standard.

Exit |

2. Run ProVis: this sub-menu brings up the ProVis 4D Simulator window that
provides the user with the 4D player. The ProVis 4D simulator is further discussed
in the 4D Simulator Window section.

3. Help: this sub-menu launches the Internet browser to preview the
DataExtracMan and

A.4.2 ProVis User Interface: 4D simulator window

The designed GUI components for ProVis 4D simulator are put together in VBA. The
functionality of the GUI is to link the 3D CAD model components with the VIRCON
database records and resources for the project activities. A window tabbed-system interface
is used which provides the end-user with the major components. The three major parts are
explained here:

1- Product Simulation Tab: a snapshot of the Product Simulation tab main
components is shown below. The user enters a specific monitor date for which the
4D simulation to start. Users are provided with 4D player buttons: next, previous,
auto run, stop, and reset the simulation. The 4D environment loads the weekly 3D-
CAD model when the user clicks on next, previous, and auto run buttons. The
simulator displays the 3D geometry with its associated tasks and resources from
VIRCON database by using Database Access Objects (DAO).
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The Legend part explains the colouring conventions for activities in progress as a red
colour, the finished activities as a white colour, and the temporary construction processes

as a yellow colour.

x|

Space Visualisation |

Legend
Date I 29-Sep-99 Back. | Run | Mext | Auto | Stop |Rsset| Ackivity IExDIDrerI Exit | ! Progressing D Temporary D Finished

2- Activities Window: is brought to display when the user clicks the Activity List
button in the Product Simulation Tab. The purpose of this window is to display the

following:

a- Display finished activities and whenever the user un-check on a specific
activity it hides/show that activity.

b- Also displays the unfinished activities (i.e. activities in progress).

Activity List F x| Activity List

Progressing | Finished |

a | 3| o | 3

3- PBS-WBS Tree Window: is brought to display when the user clicks the
Explorer button in the Product Simulation Tab. The purpose of this window is to
display the following:

a- WBS of the construction project in a tree-view style.

b- Displays finished activities and whenever the user clicks on an activity it
opens the Information window showing the chosen activity's project
information (e.g. start, end, duration, slack, etc.)
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2- Space Visualisation Tab: the space visualisation tab gives the user show/hide
options for visualising the construction activities at a chosen date. There are three
hide/show option radio buttons for viewing specific building components of the
project 3D model. The first is Show Space Conflicts that in turn switches the Space
Conflicts layer on, and hide the rest of the model. It should be noted here that this
option should only be used after pressing the Draw Space Conflicts button. The
second is the Show Building Only option button that displays only the major
building 3D components. The third option is Show All allows the user to view the
whole building model. The Draw Space Conflicts allows the user to draw space
conflicts between the assigned construction activities after space is analysed in
SpaceMan. Different types of space conflicts are drawn back on the 3D model in
different AutoCAD colours.

The Legend part explains the colouring conventions for the space conflicts overloads. It
indicates to the user the percentage of space available for continuing construction
activities.

Product Simulation  Space Visualisation

— CSA Legend
¢ Show Space Conflict ¢ Show Building Only ' Show All Draw Spatial Loadlngl Exit D Spatial Slack D Critical Space ﬂ Spatial Overload

A.5.1 Running ProVis Simulator: manual run

The ProVis manual run allows the user with more control over the 4D simulation. The
manual run controllers are the next, previous, run, and stop buttons.

Next Button: advances the simulation time by one week from the displayed
monitor time.
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Back Button: reverses the simulation time by one week from the displayed
monitor time.

Stop Button: stops the simulation.

Run Button: runs the simulation. The user inputs any desired monitoring time and
ProVis displays the construction progress at that time.

Reset Button: resets the simulation to the project stating date.
A.5.2 Running ProVis Simulator: auto run

In ProVis, press the auto run button to start the automatic run in 4D. The auto run advances
the actual monitor time week by week till it reaches the finish date in the project schedule.
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A.6.1 Distributing the 4D Visualisation: exporting the 3D model

You have several choices of file formats for exporting your 4D visualisations. The purpose
of the export is solely to distribute and share your 4D visualisations results with your
project members. It allows you to discuss the space visualisations results with your project
team and perhaps recommend further modifications based on their views.

ProVis does not contain any exporting utilities to other standard file formats. However, the
user can utilise the Export or SaveAs from AutoCAD File menu and select the specific file
format to export. Additionally, there are many available 3D software that are supported
with importing utilities for AutoCAD standard files.

This section will give you a general description about the standard exporting file formats.

45



A.6.2 Distributing the 4D Visualisation: CAD exports

AutoCAD 2000 allows you to export DWG and DXF file formats to share the ProVis
simulation with your engineering team. The following are the basic steps required to export
your construction project 4D model to other CAD applications:

1.
2.

3.

Click File > SaveAs from the AutoCAD pull down menu.

On the Save Drawing As window, select either DWG or DXF (AutoCAD
R12/LT2 DXF is preferred).

After specifying the correct path name, type the preferable file name in the
File name field.

Click Save.
Save Drawing As [ 7]
Sa\re_in:la\-fifcon ﬂ @I ﬁl 'alll
File narne: |ProiectName.dwg Save I
Save as lype: IAutoCﬁ-‘«D 2000 Drawing [*.dvag] j Cancel |
Optiong... |

A.6.3 Distributing the 4D Visualisation: desktop VR export

Virtual Reality (VR) desktop is what brings 4D visualisations to real sense. AutoCAD
2000 lacks the integration tools for producing complex VR worlds. As a solution, the user
could use the available third party 3D applications/add-on as the VR environment editor.
The following explains two examples of visualising the 4D in desktop VR.

A) VRML (WRL) Files: You could use VRML files (Virtual Reality Modelling
Language) for viewing your visualisations on your normal desktop or for
distributing the 3D worlds over the web. Here, we are going to explore the basic
steps to produce VRML worlds using 3D Studio MAX 3.1 from KINETIX.

1. In AutoCAD SaveAs window, save your project file as DXF file.

2. Launch 3D Studio MAX 3.

3. In 3D Studio MAX pull down menu, click File > Import to open the Select File
to Import window.

4. Change the import Files of type to DXF.
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5. Select the ProjectName.dxf file and click Open.

Lok jn: I*_:j Yircon :] ﬁl gl

File name: IFmiectN ame, dxf E Open |
Files of type: [ AutoCAD [~ DXF) = Cancel |
7

6. In the Import DXF File window check the Layer option of the Derive Objects
From item. Click OK.

Import DXF File

Derive Objects Fram:
& Layer
€ Color
" Entity

—wield Vertices:

‘wheld Threshold:[0.07 i’

v weld

r—Awto-Smooth:

Smooth Angle: [ 30.0 il

¥ Auto-Smoath

e Subdivision: ————
Folygon: [10.0 ﬂDegreaS
Spline: [30.0 i’DEgrEES

~ Miszellaneous:
™ Bemove Double Faces
¥ Cap Closed Entities
¥ Unify Mormals

7. After adding lights and setting cameras in 3D Studio MAX, click the Export
from the File menu to export as VRML (WRL) file format.

8. Keep the standard settings as they are in the VRML97 Exporter window and
click OK.
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9. The final VRML file can be viewed in any VRML browsers such as Cosmo
Player that runs on Netscape Internet browser
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B) DDDoolz4.0 Files: To carry out another type of visualisation in the VR environment, a
VR explorer titled as DDDoolz4.0 was developed by Eindhoven University of Technology.
This allows a direct conversion from CAD to VR through basic 3D file transfer. A 3D
AutoCAD file is imported to the VR explorer as a 3D studio file (3ds). The user can
experience a smooth navigation through the VR model. The DDDoolz4.0 is a free
download from the Internet.

A.7 Troubleshooting
This section helps you when you are facing problems running ProVis software. The

majority of error messages that could show on your screen are due to the possible
following reasons:
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1. Sometimes the 3D components do not appear when running the 4D simulation:
If this happens, then make sure you have specified the correct GroupName in the
Tasks table of the database.

2. Sometimes the 3D components stay stand still during the simulation and do not
disappear:
- It means that the 3D components were grouped and the GroupName were not
included in the Tasks table
- It could be because you have misspelled the GroupName either in the CAD
drawing or when you entered them in the Tasks table

3. If you populate the database and some objects space information (e.g. a square
column) do not appear in the specified product table then:
- Check that you have drawn that object as closed Polylines, lines and circles
- Make sure that the shapes were created in the correct layer name (e.g. ground
floor columns layer) corresponding to the specific activity.

4. The populated product tables in the database are named strangely not according to
the naming convention described in the user's guide:
- It is because the related layer had been misspelled when naming that layer.
Check the layer name spelling!
- Make sure that the shapes were created in the correct layer name (e.g. ground
floor columns layer) corresponding to the specific activity.

5. The manual/auto runs do not work and you could not view the 4D simulation:
- If the database error message appears, it means that your data link source file is
not configured.
- Reconfigure the ODBC connection from with in AutoCAD.

If you are still facing other problems with ProVis software, please contact one of our
support members and email your question to us. We will be happy to assist in any way.
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